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简介
本应用笔记详细介绍了如何配置和使用支持的嗅探工具以及基于 Microchip MCU 的嗅探器硬件平台。在 Zigbee®

网络

中，嗅探工具（如 Wireshark Network Protocol Analyzer（简称 Wireshark））用于捕捉和分析网络中交换的帧，在

开发和测试阶段至关重要。在包含不同厂商 Zigbee 产品的网络中，由于产品间需实现互操作性，因此使用 Wireshark
进行测试和验证尤为重要。本应用笔记主要重点介绍使用 Wireshark 进行数据包捕捉的方法。

Wireshark 是一款免费开源的数据包分析器。通过在 PC 上运行 Wireshark，即可搭建无线网络嗅探环境。Wireshark
的用途如下：

• 网络故障排查

• 分析

• 软件和通信协议开发

• 教学培训

Wireshark Sniffer Interface Tool（Wireshark 嗅探器接口工具）负责连接 Wireshark 图形用户界面（Graphical User
Interface，GUI）与运行在 ZigBit USB 设备上的嗅探器固件。这样，运行在 PC 上的 Wireshark Sniffer Interface Tool
应用程序便可与嗅探器硬件进行通信。Wireshark Sniffer Interface Tool 能够实时捕捉 Zigbee 协议和 IEEE® 802.15.4
标准支持的帧格式，并解析帧内各字段与子字段信息，帮助用户快速完成分析。

特性
• 网络拓扑

• 添加时间戳

• 多信道捕捉

产品页链接

 Zigbee®数据包分析
 AN4815

https://microchip.com
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1. 快速参考

1.1. 参考文档
有关详细信息，请参见以下文档：

• AT08550：ZigBee Attribute Reporting Application Note（42334）

• Atmel AT02597：ZigBee PRO Packet Analysis with Sniffer Application Note（32210）

• Atmel-ICE Programmers and Debuggers User Guide（42330）

• PRO Base Device Behavior Specification（3.0.1）

• ZigBee Alliance Cluster Library Specification Revision 8（075123）

• Matter Device Library Specification（1.0）

• Zigbee PRO Green Power feature specification Basic functionality set（Version 1.1.1）

• Zigbee Specification Revision 22 1.0（05-3474-22）

• ZigBit USB Stick User Guide（42194）

1.2. 硬件要求
• 50-mil 10 引脚 IDC 扁平线缆

• ATMEL-ICE（ATATMEL-ICE）

• ATXMEGA256A3U 和 AT86RF212B ZIGBIT USB 设备（ATZB-X-212B-USB）

• ATXMEGA256A3 和 AT86RF233 ZIGBIT USB 设备（ATZB-X-233-USB）

• Micro-AB USB 线缆

1.3. 软件要求
• Microchip Studio（7.0.2594）

• Windows® 10

• Wireshark（3.6.8）

• Wireshark Sniffer Interface Tool（v3.0.0.10）

1.4. 缩略语与缩写

表 1-1. 缩略语与缩写

缩略语与缩写 说明

API 应用程序编程接口（Application Programming Interface）

APL 应用层（Application Layer）

APS 应用支持子层（Application Support Sub-Layer）

BDB 基础设备行为（Base Device Behavior）

GP 绿色能量（Green Power）

GPC 绿色能量组合（Green Power Combo）

GPD 绿色能量设备（Green Power Device）

GPP 绿色能量代理（Green Power Proxy）

GPS 绿色能量接收端（Green Power Sink）

GUI 图形用户界面（Graphical User Interface）

NWK 网络（Network）

PAN 个人局域网（Personal Area Network）

https://ww1.microchip.com/downloads/en/Appnotes/Atmel-42334-ZigBee-Attribute-Reporting_ApplicationNote_AT08550.pdf
https://ww1.microchip.com/downloads/en/AppNotes/Atmel-32210-ZigBee-PRO-Packet-Analysis-with-Sniffer_AP-Note_AT02597.pdf?ICID=I-CT-TECH-RES-CLA-SEP_21-0
https://ww1.microchip.com/downloads/en/DeviceDoc/Atmel-ICE_UserGuide.pdf
https://csa-iot.org/wp-content/uploads/2022/01/07-5123-08-Zigbee-Cluster-Library-1.pdf
https://csa-iot.org/wp-content/uploads/2022/11/22-27351-001_Matter-1.0-Device-Library-Specification.pdf
https://csa-iot.org/wp-content/uploads/2022/01/docs-14-0563-18-batt-Green-Power-Basic-specification-v1.1.1.pdf
https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
http://ww1.microchip.com/downloads/en/devicedoc/atmel-42194-zigbit-usb-stick-user-guide.pdf
https://www.microchip.com/ATATMEL-ICE
https://www.microchip.com/ATZB-X-212b-USB
http://www.microchip.com/ATZB-X-233-USB
https://www.microchip.com/en-us/tools-resources/develop/microchip-studio#Downloads
https://www.wireshark.org/download.html
https://gallery.microchip.com/packages/%7B6BE86DC1-AC91-4148-BA34-FC70CA77D3EA%7D/
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表 1-1. 缩略语与缩写 （续）

缩略语与缩写 说明

USB 通用串行总线（Universal Serial Bus）

ZCL Zigbee®簇库（Zigbee Cluster Library）

ZDO Zigbee 设备对象（Zigbee Device Object）

ZDP Zigbee 设备配置文件（Zigbee Device Profile）
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2. Wireshark Network Protocol Analyzer 和 Wireshark Sniffer Interface
Tool 概述
本章概述了 Wireshark Network Protocol Analyzer（Wireshark）和 Wireshark Sniffer Interface Tool 的
设置及其各自的组件。默认情况下，Wireshark 和 Wireshark Sniffer Interface Tool 分别将软件包安装在

C:\Program Files\和 C:\Program Files (x86)\路径下。

表 2-1. Wireshark 软件包文件

文件名 说明

Wireshark-winXX-3.X.X.exe文件 Wireshark 可执行文件

表 2-2. Wireshark Sniffer Interface Tool 软件包文件

文件名/文件夹名称 说明

Wireshark Sniffer Interface Tool v3.0.0.10.exe Wireshark Sniffer Interface Tool 可
执行文件

C:\Program Files (x86)
\Atmel\Atmel Wireshark Sniffer
Interface Tool Folder

Atmel Wireshark 嗅探器固件 —

Atmel_Wireshark_Sniffer_Interface.exe Wireshark Sniffer Interface Tool 可
执行文件

Atmel_Wireshark_Sniffer_Interface.exe.config Atmel Wireshark Sniffer Interface
框架配置文件

Release Notes.txt
• 包含 Wireshark Sniffer

Interface Tool 的发布和版本信

息

• 用于捕捉/嗅探 IEEE® 802.15.4
帧（2.4 GHz 和 Sub-GHz）

System.Xaml.dll —

C:\Program Files (x86)
\Atmel\Atmel Wireshark Sniffer
Interface Tool\Atmel Wireshark
Sniffer Firmware Folder

AWSI_at32uc3a3256s_rz600_at86rf212.hex 用于 RZ600 USB 设备的嗅探器固

件。有关详细信息，请参见

ATAVRRZ600。
AWSI_at32uc3a3256s_rz600_at86rf231.hex

AWSI_atxmega256a3u_rf212b_zigbit_usb.hex 用于 Sub-GHz 的 ZigBit USB 设备固

件

AWSI_atxmega256a3u_rf233_zigbit_usb.hex 用于 2.4 GHz 嗅探器的 ZigBit USB
设备固件

2.1. 支持的嗅探器硬件平台
若要开始在 IEEE 802.15.4 信道上捕捉帧，用户必须将运行嗅探器固件的嗅探器硬件工具插入 PC。以下是

支持的嗅探器硬件平台：

• RF212B ZigBit USB 设备——用于嗅探 IEEE 802.15.4 Sub-GHz 信道

• RF233 ZigBit USB 设备——用于嗅探 IEEE 802.15.4 2.4 GHz 信道

https://www.microchip.com/en-us/development-tool/ATAVRRZ600
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图 2-1. 支持的嗅探器硬件平台——ZigBit USB 设备（RF212B/RF233——Sub-GHz/2.4 GHz）

使用 Wireshark Sniffer Interface Tool 为 2.4 GHz 和 Sub-GHz 范围内的 IEEE 802.15.4 信道创建捕捉会

话。Wireshark Sniffer Interface Tool 支持 ATXMEGA256A3U_RF212B 和 ATXMEGA256A3U_RF233。

2.2. Wireshark 工具和 Wireshark Sniffer Interface Tool 入门

2.2.1. Wireshark 安装步骤

若要下载 Wireshark，请访问 Wireshark。有关 Wireshark 的详细信息，请访问 Wireshark。

注：Wireshark 的稳定发布版本为 3.6.6，用户也可以从 Wireshark 官方网站获取最新开发版本并在 PC 上

进行安装。

以下是安装 Wireshark 的步骤：

1. 双击 Wireshark-winXX-3.X.X.exe以启动安装过程。

2. 单击 Next（下一步）继续。

https://www.wireshark.org/download.html
https://www.wireshark.org/
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图 2-2. Wireshark 安装窗口

2

注：用户可使用最新版 Wireshark。

3. 单击 Noted（确认）继续。

图 2-3. Wireshark——许可协议

3

4. 在“Select components to install：”（选择要安装的组件：）字段下，选中要随该工具一起安装的

组件。单击 Next 继续。
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图 2-4. Wireshark——选择组件

4

5. 在 Create Shortcuts（创建快捷方式）字段下选中所需的快捷方式，然后在 Associate File
Extensions（关联文件扩展名）字段下选中 Associate trace file extensions with Wireshark（将跟踪文

件扩展名关联至 Wireshark）。单击 Next 继续。

图 2-5. Wireshark——附加任务

5

6. 将 Wireshark 安装到“Destination Folder”（目标文件夹）字段下的默认位置：C:\Program
Files\Wireshark。单击 Next 继续。
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图 2-6. Wireshark——安装位置

6

7. 安装“Npcap”或“WinPcap”以捕捉实时网络数据。在此场景中，安装的是 Npcap 1.60。单击 Next
继续。（可选）

图 2-7. Wireshark——数据包捕捉

7

8. 安装“USBPcap”以捕捉 USB 流量。在此场景中，在“Install”（安装）字段下选中 Install USBPcap
1.5.4.0（安装 USBPcap 1.5.4.0）。单击 Install 继续。（可选）
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图 2-8. Wireshark——USB 捕捉

8

9. 用户必须等待 Wireshark 安装过程完成。安装过程完成后，单击 Next 继续。

图 2-9. Wireshark——正在安装

9

10. 单击 Finish（完成）以完成 Wirehsark 安装。
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图 2-10. Wirehark 完成安装

10

2.2.2. Wireshark Sniffer Interface Tool 安装

用户必须安装 Wireshark Sniffer Interface Tool 才能使用 Wireshark 设置捕捉会话。若要下载 Wireshark
Sniffer Interface Tool，请访问 Wireshark Sniffer Interface Tool v3.0.0.10。

以下是安装 Wireshark Sniffer Interface Tool 的步骤：

1. 双击 Atmel Wireshark Sniffer Interface Tool.exe以启动安装过程。

2. 单击 Next 继续。

图 2-11. Wireshark Sniffer Interface Tool InstallShield 向导

2

3. 将 Wireshark Sniffer Interface Tool 安装到默认位置：C:\Program Files (x86)\Atmel\Atmel Wireshark
Sniffer Interface Tool\Atmel Wireshark Sniffer Firmware。

4. 单击 Next 完成安装。

https://gallery.microchip.com/packages/%7B6BE86DC1-AC91-4148-BA34-FC70CA77D3EA%7D/
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图 2-12. 默认位置——Wireshark Sniffer Tool 安装

3

4

5. 按照 Release Notes.txt（位于软件包文件夹 Atmel Wireshark Sniffer Interface Tool
内）中的说明完成安装过程。有关详细信息，请参见 ZigBit USB Stick User Guide（42194）。

6. 在相应的 Zigbit 硬件平台上刷写嗅探器固件。有关详细信息，请参见将固件刷写到 ZigBit USB 设备

中。以下是软件包中提供的映像：

– AWSI_at32uc3a3256s_rz600_at86rf212.hex
– AWSI_at32uc3a3256s_rz600_at86rf231.hex
– AWSI_atxmega256a3u_rf212b_zigbit_usb.hex
– AWSI_atxmega256a3u_rf233_zigbit_usb.hex

2.3. 将固件刷写到 ZigBit USB 设备中
以下是将固件刷写到 ZigBit USB 设备的步骤：

1. 使用 Atmel ICE JTAG 线缆连接 Atmel ICE 中的 AVR®连接器端口与 JTAG 编程连接器（J2）。有关详细

信息，请参见 ZigBit USB Stick User Guide（42194）。

2. 使用 USB 线缆将 Atmel ICE 连接到 PC 的一个 COM 端口，并将 ZigBit USB 设备连接到 PC 的另一个

COM 端口。有关详细信息，请参见 Atmel-ICE Programmers and Debuggers User Guide（42330）。

图 2-13. Atmel ICE Zigbit 嗅探器连接

USB Port

JTAG Programming
Header (J2)

50-mil 10-pin 
IDC Flat Cable

Zigbit USB Stick

Atmel ICE 

AVR 
Connector Port

SAM 
Connector Port

http://ww1.microchip.com/downloads/en/devicedoc/atmel-42194-zigbit-usb-stick-user-guide.pdf
http://ww1.microchip.com/downloads/en/devicedoc/atmel-42194-zigbit-usb-stick-user-guide.pdf
https://ww1.microchip.com/downloads/en/DeviceDoc/Atmel-ICE_UserGuide.pdf
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3. 打开 Microchip Studio，转到 Tools > Device Programming（工具 > 器件编程）并选择相应的工具、器

件和接口。

图 2-14. 器件编程

4. 用户必须选择以下字段：

– 从“Tool”（工具）下拉列表中选择 Atmel-ICE。

– 从“Device”（器件）下拉列表中选择 ATxmega256A3U。

– 从“Interface”（接口）下拉列表中选择 JTAG。

图 2-15. 器件编程字段

4

5. 固件映像位于以下目录中：\Atmel Wireshark Sniffer Interface Tool\Atmel Wireshark Sniffer
Firmware。从默认位置（步骤 3）加载 Wireshark 嗅探器固件，然后将固件刷写到 ZigBit 嗅探器中。

6. 断开 Atmel ICE 与 ZigBit USB 设备的连接。

7. 通过 USB 将 ZigBit USB 设备连接到 PC，然后打开 Atmel Wireshark Sniffer Interface Tool。
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图 2-16. 将 ZigBee USB 设备连接到 PC

ZigBit USB Stick
PC

Via USB
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3. 嗅探器捕捉会话设置
本章提供有关在 PC 中成功安装 Wireshark Sniffer Interface Tool 后如何设置嗅探器捕捉会话的详细信

息。

3.1. Wireshark 数据包捕捉步骤
1. 从开始菜单中单击 Atmel Wireshark Sniffer Interface Tool 以启动 Wireshark Sniffer Interface Tool。

2. 从“Sniffer Port”（嗅探器端口）下拉列表中选择 COM30（用于举例说明）。

3. 从“Baudrate”（波特率）下拉列表中选择 115200。

4. 单击 Connect（连接）继续。

图 3-1. Atmel Wireshark Sniffer Interface Tool 的启动窗口

2
3 4

Play

Stop Pause

Save

5. 从“Channel”（信道）下拉列表中选择 11（用于举例说明）。

注：用户可根据要求选择“Channel”。下面是可选值：

– 对于 Sub-GHz，范围为 0-10。

– 对于 2.4 GHz，范围为 11-26。

6. 从“Channel Page”（信道页）下拉列表中选择 0（用于举例说明）。可选值范围为 0-10。
注：用户可根据定制数据速率要求调整“Channel Page”。

7. 单击 Play（开始）以开始捕捉。
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图 3-2. 信道/信道页/开始按钮

5
6

7

注：

• AT86RF233 ZIGBIT USB 设备（2.4 GHz）支持以下数据速率：

– 信道页 0——数据速率为 250 kbps

– 信道页 2——数据速率为 500 kbps

– 信道页 16——数据速率为 1 Mbps

– 信道页 17——数据速率为 2 Mbps

• AT86RF212B ZIGBIT USB 设备（Sub-GHz）支持以下数据速率：

– 信道页 0——数据速率为 20 kbps（信道 0）和 40 kbps（信道 1-10）

– 信道页 2——数据速率为 100 kbps（信道 0）和 250 kbps（信道 1-10）

– 信道页 5——数据速率为 250 kbps

– 信道页 16——数据速率为 200 kbps（信道 0）和 500 kbps（信道 1-10）

– 信道页 17——数据速率为 400 kbps（信道 0）和 1 Mbps（信道 1-10）

– 信道页 18——数据速率为 500 kbps

– 信道页 19——数据速率为 1 Mbps

随后弹出以下窗口，其中显示在 Wireshark 中捕捉的数据包。
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图 3-3. Wireshark 启动窗口

a. 转到 Analyze > Enabled Protocols（分析 > 已使能协议）以选择协议。

图 3-4. 已使能协议选择

7a

b. 用户可根据要求选择协议。例如，在此场景中，搜索 zbee 以选择 ZigBee 协议。

c. 单击 OK（确定）继续。
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图 3-5. 协议选择

7b

7c

8. 单击 Pause（暂停）以暂停捕捉数据包。

9. 单击 Stop（停止）以停止捕捉数据包。

图 3-6. 暂停/停止按钮

9 8

a. 随后弹出以下对话框，用户必须单击 Yes（是）或 No（否）以保存或删除捕捉文件（如果先前的

信道/实例中有发生任何捕捉）。
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图 3-7. 保存 Wireshark 嗅探器数据

9a

10. 用户可保存捕捉的文件以供将来参考，也可在不保存的情况下继续。

注：用户必须确保在系统环境变量中添加 Wireshark-winXX-3.X.X.exe的路径。

11. 下图显示了 PC 的设备管理器中的 ZigBit 2.4 GHz USB 设备。
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图 3-8. Windows 设备管理器中列出的 ZigBit 2.4 GHz USB 设备 COM 端口（嗅探器）
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4. 配置嗅探器首选项
Wireshark 的 GUI 提供多种筛选选项，便于查看和分析。用户可通过适当的设置获得无线网络的完整概

况。本章提供有关在 Wireshark 的 GUI 中配置此类首选项的信息。

4.1. Wireshark 捕捉界面
• 协议——Wireshark 自动识别正在使用的协议。默认情况下使能所有支持的协议，转到 Analyze >

Enabled Protocols 可查看所有菜单选项。用户可使用该选项根据要求使能或禁止协议。

注：用户必须确保在捕捉数据包之前使能全部所需的协议。

• 安全——可通过输入网络中使用的网络（NWK）安全密钥来监视加密的 ZigBee 网络数据。转到 Edit >
Preferences > Protocols > ZigBee（编辑 > 首选项 > 协议 > ZigBee）。下图显示了 Wireshark 中的安全

密钥配置选项。

– 从“Pre-configured Keys”（预配置密钥）中单击 Edit（编辑）以输入安全密钥（见图 4-2）。

图 4-1. Wireshark 中的安全首选项

可根据 Zigbee Specification Revision 22 1.0 设置安全级别。下表提供了有关安全级别的详细信息。

表 4-1. NWK 和应用支持子层（APS）可用的安全级别

安全级别标识符 安全级别子字段 安全属性 数据加密 帧完整性（MIC 的长度

M，以八位字节数为单

位）

0x00 000 无 关闭 否（M = 0）

0x01 001 MIC-32 关闭 是（M = 4）

0x02 010 MIC-64 关闭 是（M = 8）

0x03 011 MIC-128 关闭 是（M = 16）

0x04 100 ENC ON 否（M = 0）

0x05 101 ENC-MIC-32 ON 是（M = 4）
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表 4-1. NWK 和应用支持子层（APS）可用的安全级别 （续）

安全级别标识符 安全级别子字段 安全属性 数据加密 帧完整性（MIC 的长度

M，以八位字节数为单

位）

0x06 110 ENC-MIC-64 ON 是（M = 8）

0x07 111 ENC-MIC-128 ON 是（M = 16）

注：有关安全级别的详细信息，请参见 Zigbee Specification Revision 22 1.0（05-3474-22）中的 Table 4-30 Security Levels Available
to the NWK, and APS Layers。

可添加多个密钥以及编辑或删除现有密钥。下图显示了安全密钥条目。

例如，对于在 APS 层使用集中式安全的 Zigbee 网络，加入网络的设备会与信任中心建立链路密钥。若要

查看该链路中发生的所有 APS 事务（如 APS Transport Key命令），请在 Wireshark 的首选项选项卡

下添加信任中心链路密钥和网络密钥（见下图）。

图 4-2. 安全密钥条目

用户可在 Wireshark 中自定义以下查看选项：

• 若要编排面板的布局，请转到 Edit > Preferences > Layout（编辑 > 首选项 > 布局）。

• 若要向数据包显示窗格中添加列（如 HW Src Addr），请转到 Edit > Preferences > Columns（编辑 >
首选项 > 列）。

• 若要对帧格式进行着色（如 NWK 链路状态帧），请转到 View > Coloring Rules（查看 > 着色规则）。

有关详细信息，请参见 Packet colorization（11.3）。

• 按照以下步骤应用筛选器，以根据帧中所选的字段显示帧：

a. 右键单击字段

b. 选择 Apply as Filter（应用为筛选器）

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
https://www.wireshark.org/docs/wsug_html_chunked/ChCustColorizationSection.html
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图 4-3. Wireshark 捕捉屏幕布局
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5. 分析 Zigbee Pro 网络中的数据流量
本章提供 Zigbee Pro 网络中的常见交互示例，帮助用户解析帧的各个字段。

注：本章内容并未涵盖 Zigbee 规范中的所有场景。

5.1. Zigbee 帧格式概述
下图给出了 Zigbee 帧格式的结构概览（包括 APS 和 NWK 层的安全帧头和帧尾）。Zigbee 使用一种非信

标使能的 MAC 格式，MAC 层没有安全机制。

图 5-1. Zigbee 帧格式

PHY

MAC

NWK

APS

ZDO/ZCL/APP

Header

Header

Header

Header

Header

MIC

MIC

Footer

AUX

AUX

Payload

Payload

Payload

Payload

SHR

5.2. MAC 关联
Zigbee 网络中的每个节点都有其惟一的 64 位 IEEE MAC 地址。当节点首次加入网络时，终端设备/路由器

将发起 MAC 关联过程，之后将从父节点获取一个 16 位网络（短）地址。为降低帧开销，网络内的后续通

信均使用该短地址。在编译期间，可使用配置参数“IEEE MAC 地址”设置该节点的 64 位 MAC 地址值。

具体情况如下：

• 针对测试设置 IEEE MAC address——可在编译时通过应用程序配置文件设置任意随机的 64 位值，

或者在运行时调用应用程序编程接口（API）启动网络请求之前通过 ZDP 进行设置。

• 在生产期间设置 IEEE MAC address——Zigbee 产品的商业用途需要从 IEEE 购买一个 IEEE/MAC 地

址块。在这种情况下，可在编译期间将 IEEE MAC address设置为零。

节点启动时，会通过在 Zigbee 协议栈参数配置文件或应用程序级别配置的信道列表中指定的信道上执行主

动扫描来进行网络发现。节点发送 Beacon Request（见数据包#1）（见下图）。网络中已有的路由器

和协调器收到 Beacon Request帧后会自动以信标帧进行响应。入网节点根据收到的信标数据包中的设

置来筛选潜在的父节点。
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图 5-2. 节点使用 IEEE 地址 0xdeeb1ULL 通过 MAC 关联加入网络

来自协调器/路由器的信标包含 Association Permit子字段。如果该设备接受与个人局域网

（Personal Area Network，PAN）的关联，则该子字段设置为 True。如果该子字段设置为 False，则入

网节点无法与该设备关联。Zigbee 应用程序中的 PERMIT DURATION参数通过设置有限的准入持续时间

来控制设备加入网络。

图 5-3. 信标帧中的 assocPermit 子字段

例如，下图显示了解析后的信标有效负载，其中包含的信息是入网节点选择潜在父节点的依据。

信标有效负载提供了网络中使用的 Zigbee 协议栈配置文件（Stack Profile: ZigBee PRO = 0x2）
和网络协议版本（nwkcProtocolVersion, 0x02）信息。Router Capacity、End Device
Capacity和 Device Depth会限制父节点对子节点的接受能力。有关详细信息，请参见 Zigbee
Specification Revision 22 1.0（05-3474-22）。

图 5-4. 信标有效负载

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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下图显示了入网设备在其发送给潜在父节点的 MAC Association Request中所指示的自身能力信息。

图 5-5. MAC 关联请求中的能力信息

5.3. 自主离网和父节点触发离网
Zigbee 设备对象（ZDO）层负责管理 ZDP 请求，并将其用于各种网络控制场景。

如果设备需要在发生特定事件时离开网络，可使用 ZDP 请求来处理离网操作。离网可以由节点自身发起，

也可以由一个节点指示另一个远程节点离开网络。

下图显示了短地址为 0x457a的节点。该节点自主离开网络（自主触发），并通过发送重新加入请求来重

新加入网络（见数据包#3300）。

图 5-6. 短地址为 0x457a 且扩展地址为 0xdeeb1ULL的节点（终端设备）自主离网

该节点之所以能重新入网是因为 Command Frame: Leave中的 Rejoin位设置为 True。下图显示了离

网数据包的重新加入位设置。

图 5-7. 离网数据包的重新加入位设置

下图显示了父节点请求短地址为 0x6915的子设备离网（Leave Request）（见数据包#99）的情况。子

设备发送重新加入响应（见数据包#101）。几秒钟后，子设备使用相同的短地址重新加入网络。在这种情

况下，子设备重新加入的是一个网络参数（如网络 PANID）已知的网络。
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图 5-8. 父节点 0x0000 发送 ZDP 请求指示子节点 0x6915 离网

下图显示了父节点请求子设备离开网络且不重新加入的情况。

图 5-9. 不允许重新入网的父节点触发离网

图 5-8 与图 5-9 之间的区别在于重新加入位的设置。

• 如果重新加入位设置为 True，则离网设备使用重新加入请求来重新加入网络。

• 如果重新加入位设置为 False，在调用子设备加入网络的情况下，可通过 MAC 关联实现重新入网。

可在离网请求中配置子节点重新入网和移除等选项。

5.4. 网络（NWK）链路状态帧
路由器和协调器会发送网络（NWK）链路状态帧，以便相邻节点能够维护路由所需的链路成本信息。Link
Status帧会定期以单跳广播形式传输。Link Status列表中包含所有相邻节点的短地址和链路成本信

息。下图显示了 NWK 链路状态帧中的帧头信息。
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图 5-10. NWK 链路状态命令帧

5.5. 多播
向一组节点广播报文涉及到为指定的端点和组 ID 创建组表条目。下图显示了从协调器到组的多播传输，其

中组 ID 为 Group: 0x1111，端点为 0x20。网络目标地址即为组地址。

图 5-11. 多播子字段——NWK 帧头

5.6. 分片
当应用层（APL）数据包的长度超过 APL 有效负载的最大限值时，协议栈会将整个数据分割成多个数据

块。
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图 5-12. 分片——相关帧头信息

下图给出了一个分片示例。

图 5-13. 分片——示例

发送节点发送第一个分片时，其块编号等于组成整个 APL 数据的总块数。后续分片的块编号从 1 开始，直

到最大传输窗口大小。接收节点在接收到传输窗口中的所有块后发送 APS 应答帧。有关详细信息，请参见

Zigbee Specification Revision 22 1.0（05-3474-22）。

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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5.7. 服务发现
服务发现是收集网络中其他设备所支持的簇信息的过程。服务发现会为每个支持的簇 ID 使用 ZDP 请求。

服务发现请求可以是单播或广播，因此响应中会包含响应者的网络地址以及匹配的简单描述符信息。响应

包含一个匹配列表，其中会列出支持所请求簇的端点。有关服务发现的详细信息，请参见分析 Zigbee 3.0
协议中的数据流量。

5.8. 安全网络中的隧道传输
考虑这样一种网络场景：某个节点通过路由器父节点以非安全方式入网，并且该入网节点在加入过程之前

并不知道网络密钥。在这种情况下，使用 APS 命令将网络密钥从信任中心安全地传输到新加入的路由器，

该命令称为 APS 隧道命令。

终端设备 0x0beeLL通过数据包#89加入路由器 0x3c08。父路由器会向信任中心发送 APS Update
Device命令（数据包#91），以通知其有节点加入或离开网络。下表和图 5-15 提供了有关设备更新状态

的详细信息，信任中心据此采取必要的操作，即发送网络密钥或者移除该设备的密钥及相关安全计数器。

图 5-14. 隧道传输

信任中心在数据包#93中发送 APS 隧道命令帧。该隧道命令帧的有效负载中包含要发送到目标的安全帧。

数据包#95显示了从路由器父节点发送到新加入的终端设备的 APS Transport Key命令帧，其中包含密

钥序列号和有效网络密钥。如果路由器使用预配置的网络密钥加入，则尽管 APS 传输数据包中包含密钥序

列号，但密钥值为全零。终端设备接收 Transport Key命令帧，设置并激活网络密钥，然后向网络发出

设备通告（数据包#97和#98）。

表 5-1. APS 更新设备命令中的状态字段

参数名称 类型 有效范围 说明

状态 整数 0x00-0x07 指示由 DeviceAddress 参数指定的设备的更新状态。

• 0x00 = 标准设备以安全方式重新入网

• 0x01 = 标准设备以非安全方式入网

• 0x02 = 设备离网

• 0x03 = 标准设备以非安全方式重新入网

• 0x04 = 高安全性设备以安全方式重新入网

• 0x05 = 高安全性设备以非安全方式入网

• 0x06 = 保留

• 0x07 = 高安全性设备以非安全方式重新入网

注：有关 APS 更新设备命令中状态字段的详细信息，请参见 ZigBee Specification Revision 22 1.0 （05-3474-22）。

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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图 5-15. 更新设备状态
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6. 分析 Zigbee 3.0 协议中的数据流量
Zigbee 联盟定义了一组标准设备类型。这些设备类型规定了设备的功能。该功能又依赖于称为簇的独立功

能实体。簇是属性的容器，可通过 Zigbee 设备配置文件（ZDP）定义的命令/响应进行读/写。该联盟还提

供了 Zigbee 簇库（ZCL），作为簇功能的资源库。

本次数据包捕捉使用 Wireshark/Zigbit 嗅探器执行，针对的是多种 Zigbee 设备类型组合之间的数据传

输。以下是三种 Zigbee 设备类型：

• Zigbee 协调器/Zigbee 组合接口——能够控制和监视其他设备的设备。通常为市电供电设备，例如个人

计算机。

• Zigbee 路由器/Zigbee 灯具——可以打开/关闭的照明设备。可通过颜色命令调整灯光的亮度和颜色。

• Zigbee 终端设备/Zigbee 多传感器

以下是两种 Zigbee 网络架构：

• 集中式网络——Zigbee 协调器设备可以组建集中式网络。

• 分布式网络——Zigbee 路由器设备可以组建分布式网络。

数据包捕捉侧重于以下场景：

• Zigbee 协调器——集中式网络组建（Zigbee 组合接口应用）。Zigbee 协调器与 Zigbee 路由器

（Zigbee 扩展彩色灯）之间的调试和数据交换。有关详细信息，请参见 Zigbee 协调器。

• Zigbee 路由器——扩展灯具应用被调试接入由 Zigbee 协调器组建的现有 Zigbee 网络（组合接口或

Zigbee 路由器能够组建新的 Zigbee 分布式网络（如果附近没有网络））。在此场景中，它被调试接入

由 Zigbee 协调器/组合接口组建的现有 Zigbee 集中式网络。有关详细信息，请参见 Zigbee 路由器。

• Zigbee 终端设备——加入 Zigbee 协调器（组合接口）。加入后，终端设备（多传感器/传感器设备类

型）在连接到由协调器组建的网络后开始报告传感器数据（如温度、占用状态、光照和湿度）的 ZCL 属

性。有关详细信息，请参见 Zigbee 终端设备。

• Touchlink 调试——在本应用笔记中，调试过程发生在 Zigbee 扩展灯具（路由器）与彩色场景控制器

（终端设备）之间。有关详细信息，请参见 Touchlink 调试。

6.1. 概述

6.1.1. 基础设备行为（BDB）
BDB（基础设备行为）层支持运行在 Zigbee PRO 协议栈上的基础设备的初始化、调试和操作过程，以确

保配置文件互操作性。有关详细信息，请参见 PRO Base Device Behavior Specification（3.0.1）。

调试
调试是初始化设备以加入网络并协同工作的过程。Zigbee BDB 规范规定了以下调试机制的执行顺序：

1. Touchlink——节点可支持基于接近度的调试机制。如果支持 touchlink 调试，则节点支持作为发起

方、目标方或两者的 touchlink。
– 发起方——现有网络的成员，或者（如果不是）创建一个新网络

– 目标方——由发起方添加到网络

2. 网络引导——所有节点均支持网络引导。

– 未加入网络的节点——搜索并加入一个开放网络的行为

– 已加入网络的节点——开放网络以允许新节点加入的行为

3. 网络组建——节点以其网络安全模型组建网络的能力。这取决于节点的逻辑设备类型。

– Zigbee 协调器——组建集中式安全网络

– Zigbee 路由器——组建分布式安全网络
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4. 查找和绑定——以下是查找和绑定中的两个过程：

– 发起方端点——通过使用识别簇与匹配簇，自动搜索并与目标端点建立应用层连接。

– 目标方端点——处理来自发起方端点的查找和绑定请求

6.1.2. 网络安全模型
Zigbee 网络可支持集中式安全模型（集中式安全网络）或分布式安全模型（分布式安全网络）。除 Zigbee
协调器外的所有设备都能够加入支持任一模型的网络，或适应其所加入网络的安全条件。有关详细信息，

请参见 Zigbee Specification Revision 22 1.0（05-3474-22）。

集中式安全网络
集中式安全网络是由具备信任中心功能的 Zigbee 协调器组建的 Zigbee 网络。信任中心会对每个加入此类

网络的节点进行身份验证，通过身份验证的节点才能在网络上运行。创建集中式网络后，Zigbee 协调器设

备不得尝试加入其他网络。

默认全局信任中心链路密钥
所有设备均支持的链路密钥，用于在没有其他特定链路的情况下加入集中式安全网络。

在集中式网络中，使用以下密钥允许设备入网。

• 全局信任中心链路密钥——可使用该链路密钥加入集中式安全网络。该密钥的值为 0x5a 0x69 0x67
0x42 0x65 0x65 0x41 0x6c 0x6c 0x69 0x61 0x6e 0x63 0x65 0x30 0x39。

• 安装码链路密钥——从入网设备的安装码派生出的链路密钥，用于创建入网时使用的惟一信任中心链路

密钥。

分布式安全网络
分布式安全网络是由 Zigbee 路由器组建的 Zigbee 网络，不具备信任中心功能。父节点会对每个加入此类

网络的节点进行身份验证，通过身份验证的节点才能在网络上运行。被指定为 Zigbee 路由器逻辑设备类型

的节点可尝试加入现有的集中式或分布式安全网络。不过，Zigbee 路由器不能组建集中式安全网络，但可

以组建分布式安全网络。被指定为 Zigbee 终端设备逻辑设备类型的节点可尝试加入现有的集中式或分布式

安全网络。

APL 层安全

• Transport Key服务——支持以安全方式将密钥传输到其他设备。通过安全传输密钥命令，可将链路

密钥或网络密钥从密钥源（如信任中心）传输到其他设备。

• Request Key服务——支持设备以安全方式从信任中心请求端到端应用链路密钥或信任中心链路密

钥。

• Verify Key服务——支持设备以安全方式验证自身与信任中心是否就设备链路密钥的当前值达成一

致。

• Confirm Key服务——支持信任中心以安全方式确认先前的验证链路密钥请求。

有关详细信息，请参见 PRO Base Device Behavior Specification（3.0.1）。

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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信任中心链路密钥交换过程

图 6-1. 信任中心链路密钥交换过程序列图

Joining ZigBee
Router or ZigBee 

End Device 

Use Link Key A 
untill Successful Verification 

of Link Key B Do Not Discard Link Key A 
untill Successful Verificarion 

of Link Key B 

ZigBee Router

Legend
NWK Encrypted Only

APS Encrypted Only

NWK+APS Encrypted

Unencrypted Message

MAC Association
(Unencrypted)

APS Transport Key: NWK
(APS Encrytped with Link Key A)

APS Transport Key: Link Key B
(APS Encrytped with Link Key A)

APS Confirm Key: Link Key B
(APS Encrytped with Link Key A)

APS Request Key
(APS Encrytped with Link Key A)

APS Tunnel Command
(Transport Key)

APS Update Device

ZDO: Device Announce
(Broadcast)

ZDO: Node Descriptor Request

ZDO: Node Descriptor Response

APS Verify Key

Time

Trust Center

有关详细信息，请参见 PRO Base Device Behavior Specification（3.0.1）。

6.1.3. Zigbee 设备配置文件（ZDP）
设备发现
设备发现机制使设备能够发现 PAN 上其他设备的身份。64 位 IEEE 地址和 16 位网络地址均支持设备发

现。

• 设备通告——使网络上的 Zigbee 设备能够通知其他 Zigbee 设备该设备已加入或重新加入网络。此外，

还有助于识别设备的 64 位 IEEE 地址和新的 16 位 NWK 地址，并向远程设备通告该 Zigbee 设备的能

力。该原语的目标地址广播给所有 macRxOnWhenIdle = True的设备。有关详细信息，请参见

Zigbee Specification Revision 22 1.0（05-3474-22）。

服务发现
设备使用服务发现过程来发现其他设备的能力，或识别支持类似服务（簇）的其他设备。服务发现后，设

备将知晓支持相同簇的设备的端点和地址。为完成该过程，需对给定设备上的每个端点发出查询，或使用

匹配服务功能（广播或单播）。服务发现机制定义并利用各种描述符来概述设备的能力。服务发现在

Zigbee 设备对象内实现。有关详细信息，请参见 Zigbee Specification Revision 22 1.0（05-3474-22）。

服务发现是 Zigbee 网络中的设备识别支持类似服务（簇）的其他设备的过程。服务发现后，设备将知晓支

持相同簇的设备的端点和地址。

• 节点描述符——包含有关 Zigbee 节点能力的信息。本地设备通过发起服务发现机制来获取远程设备的

节点描述符。该数据包能够以单播形式传输到远程设备本身或包含远程设备发现信息的其他设备。

• 简单描述符——允许查询设备获取所提供端点的簇详细信息。该数据包支持单播。

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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6.1.4. Zigbee 簇库规范（ZCL）
属性报告
报告簇的属性是指使用特定的 ZCL 属性报告命令将特定簇属性的值返回到支持该簇的远程端点。

属性报告在设备成功加入 Zigbee 网络并完成服务发现后开始。服务发现后，设备将知晓与其支持相同簇的

设备的端点和地址。充当服务器簇的设备可向支持相同簇的客户端发送周期性报告。

有关详细信息，请参见 ZigBee Alliance Cluster Library Specification Revision 8（075123）。

周期性报告
周期性报告有以下类型：

• 自动报告——用户可在编译时或运行时从应用程序配置簇的报告间隔。Zigbee 协议栈应用程序在每个

最大报告间隔周期发送一次周期性报告。

• 基于属性值变化进行报告。

• 手动报告——应用程序可随时通过 ZCL 层使用属性请求发出报告。

有关详细信息，请参见 AT08550: ZigBee Attribute Reporting Application Note（42334）。

https://csa-iot.org/wp-content/uploads/2022/01/07-5123-08-Zigbee-Cluster-Library-1.pdf
https://www.avrfreaks.net/sites/default/files/forum_attachments/AT08550_ZigBee_Attribute_Reporting_0.pdf
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图 6-2. 属性报告——典型数据包交换序列

Client Server

Max Report 
Interval

New Max 
Report Interval

Min Report
Interval

Max Report
Interval

Periodic Attribute
Reports

Periodic Attribute
Reports

Periodic Attribute
Reports

Service Discovery and Cluster Binding

Configure Reporting - Timeout Period

Configure Reporting Response

Configure Reporting - Report Intervals

Configure Reporting Response

Configure Reporting - Reportable Change

Configure Reporting Response

Reporting Attributes Command

Reporting Attributes Command

Reporting Attributes Command

6.2. Zigbee 协调器
在 Zigbee 集中式网络中，由 Zigbee 协调器组建网络。其他路由器和终端设备可在网络组建后加入。

以下章节详细阐述了 Zigbee 协调器设备类型（与 Zigbee 路由器）的关联、调试、查找和绑定、属性报告

以及安全密钥交换过程。

6.2.1. 调试

6.2.1.1. Zigbee 协调器/组合接口的集中式网络组建和网络引导
下图显示了网络地址为 0x0000的 Zigbee 协调器/组合接口设备组建网络以及允许其他设备加入网络的网

络引导场景。

在调用网络组建调试过程后，协调器发送 Beacon Request数据包（见数据包#1），随后进行 MAC 关

联过程。有关详细信息，请参见 MAC 关联。
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协调器组建网络后，将发送 Link Status（见数据包#2）。有关详细信息，请参见网络（NWK）链路状

态帧。

允许入网 ZDP 请求旨在通过 MAC 关联为目标节点提供入网许可。该请求既可作为单播命令仅发送给一个

节点，也可作为广播命令进行发送。根据有效负载的 Permit Duration字段，允许在给定的秒数间隔内

通过 MAC 关联入网或永久禁止入网。该字段指定从接收到请求的时刻起，允许通过关联入网的持续时间。

数据包#3显示了 Permit Join Request，协调器设备以广播数据包形式发送该请求。有关详细信息，

请参见 MAC 关联。

图 6-3. ZigBee 协调器的网络组建和网络引导

Packet #1
Packet #2

Packet #3

准入持续时间数据包的准入持续时间为 Duration: 180。路由器/终端设备必须在 180 秒内通过 MAC 关

联加入网络。

若要在 180 秒后开放网络并允许其他设备加入，用户必须在其他设备启动调试之前向协调器输入以下命

令：

• setPermitJoin 180——在接下来的 180 秒内开放网络

• invokeCommissioning 8 0——为查找和绑定过程开放网络

图 6-4. 协调器的允许入网数据包

MAC 关联——如果任何路由器/终端设备尝试通过 Beacon Request加入网络，协调器会发送 Beacon
帧（见数据包#7）。然后，设备通过 MAC Association Request加入网络，协调器以 Association
Response（见数据包#12）进行响应。下图显示了 MAC 关联——协调器。有关详细信息，请参见 MAC
关联。
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图 6-5. MAC 关联——协调器

6.2.2. 服务发现
节点描述符——路由器/终端设备在查找和绑定之前的初始化过程中请求节点描述符。有关节点描述符的详

细信息，请参见 Zigbee 设备配置文件（ZDP）。

• 数据包#18——显示了来自路由器节点的 Node Descriptor Request
• 数据包#20——显示了来自协调器节点的 Node Descriptor Response

图 6-6. 节点描述符

下图显示了来自协调器设备的 Node Descriptor Response，用户可在 ZigBee Device Profile
下看到协调器节点的以下信息：

• Capability Information
• Max Buffer Size
• Server Flags
• Descriptor Capability Field
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图 6-7. 节点描述符响应

简单描述符——从协调器接收到 Identify Query Response后，路由器识别目标方端点并向目标方端

点（协调器）发送简单描述符请求。数据包#53和#55分别是来自路由器和协调器设备的 Simple
Descriptor Request和 Simple Descriptor Response。有关详细信息，请参见 Zigbee
Specification Revision 22 1.0（05-3474-22）。

图 6-8. 简单描述符——协调器和路由器

下图显示了来自协调器的 Simple Descriptor Response，其中列出了其支持的输入和输出簇。

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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图 6-9. 简单描述符响应

6.2.3. 查找和绑定
配置为目标方端点和发起方端点的设备如下：

• 目标方端点——Zigbee 协调器/组合接口

• 发起方端点——Zigbee 路由器/扩展灯具

作为目标方端点的协调器接收来自路由器的 Identify Query请求，协调器向发起方端点（路由器）发

送 Identify Query Response。
下图显示数据包#57和#58分别是来自路由器和协调器设备的 Identify Query请求和 Identify
Query Response。
目标方端点在有限持续时间内标识自身，然后处理来自发起方端点的后续查找和绑定请求。

图 6-10. 标识查询

下图显示了目标方端点的 Identify Timeout: 135 seconds。

图 6-11. 标识超时
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当标识超时属性递减至零时，目标设备将终止针对目标方端点的查找和绑定过程。

6.2.4. 报告
作为客户端的设备能够发起设备发现、服务发现、绑定或网络管理请求。作为服务器的设备为这些请求提
供服务并予以响应。客户端和服务器角色并非互斥，一个给定的设备可同时充当客户端和服务器。

设备配置文件以如下两种配置之一来描述设备：

• 客户端——通过设备配置文件报文向服务器发出请求

• 服务器——向发起设备配置文件报文的客户端发出响应

下表提供了 Microchip Zigbee 协议栈中组合接口设备类型可用的客户端/服务器簇的详细信息。有关详细

信息，请参见 ZigBee Alliance Cluster Library Specification Revision 8（075123）。有关特定设备类型的强

制或可选簇的详细信息，请参见 Matter Device Library Specification（1.0）。

注：组合接口设备类型仅在 Microchip Zigbee 协议栈中受支持。

表 6-1. 支持的簇——组合接口

设备类型 服务器簇 ID 服务器簇 客户端簇 ID 客户端簇

组合接口

0x0000 基本 0x0000 基本

0x0003 识别 0x0003 识别

0x0004 组 0x0004 组

0x000A 时间 0x0005 场景

0x0501 IAS ACE 0x0006 开/关

0x0008 级别控制 0x0009 报警

0x0300 颜色控制 0x0201 温控器

— — 0x0202 风扇控制

— — 0x0406 占用检测

— — 0x0400 照度测量

— — 0x0402 温度测量

— — 0x0204 温控器 UI

— — 0x0405 含水量测量

— — 0x0500 IAS 区域

在此场景中，协调器/组合接口配置为目标方端点；因此，协调器设备不报告任何属性。该设备监视由路由

器/终端设备报告的属性。

6.2.5. 安全
地址为 0x0000的 Zigbee 协调器/组合接口设备充当信任中心，地址为 0x0401的设备充当 Zigbee 路由

器（见下图）。有关集中式安全机制的详细信息，请参见网络安全模型。

根据图 6-1，MAC 关联数据包未加密。关联过程完成后：

1. 信任中心发送 Transport Key（地址为 0x0000的协调器），入网设备从中接收链路密钥（路由器

——0x0401）（见数据包#14）。承载传输密钥的 APS帧使用链路密钥 A 进行加密。

2. 入网设备（路由器）执行设备通告（见数据包#16和#17）。

3. 协调器与路由器在初始化过程中交换节点描述符（见数据包#18到#22）。

4. 数据包#23显示路由器向信任中心发送请求密钥，以请求链路 Key B。链路 Key A 保护承载该请求密

钥的 APS 帧。

5. 信任中心通过 Transport Key传输（数据包#25）所请求的密钥，并由链路 Key A 进行 APS加密。

6. 数据包#27显示了 Verify Key，确保信任中心和入网设备就同一密钥达成一致。

https://csa-iot.org/wp-content/uploads/2022/01/07-5123-08-Zigbee-Cluster-Library-1.pdf
https://csa-iot.org/wp-content/uploads/2022/11/22-27351-001_Matter-1.0-Device-Library-Specification.pdf


 AN4815
分析 Zigbee 3.0 协议中的数据流量

 应用笔记

© 2026 Microchip Technology Inc. 及其子公司

DS00004815A_CN - 43

7. 数据包#29显示了 Confirm Key，允许信任中心确认先前的验证链路密钥请求。

图 6-12. 集中式网络中的信任中心密钥交换

1

2

3

4

5

6

7

下图显示了 Transport Key，其中高亮显示了用于加密 APS层的链路 Key A（5a 69 67 42 65 65 41 6c
6c 69 61 6e 63 65 30 39）。默认情况下，网络密钥用于簇命令。下图高亮显示了网络密钥 Key: cc cc
cc cc cc cc cc cc cc cc cc cc cc cc cc cc。

图 6-13. APS 隧道传输密钥

下图显示了 Request Key，其中高亮显示了用于加密 APS 层的链路 Key A（5a 69 67 42 65 65 41 6c 6c
69 61 6e 63 65 30 39）。
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图 6-14. 请求密钥

下图显示了 Transport Key，其中高亮显示了用于加密 APS 层的链路 Key A（5a 69 67 42 65 65 41 6c
6c 69 61 6e 63 65 30 39）。下图显示了正在从信任中心传输到路由器的链路 Key B（fb 40 45 17 7a 0a
bc 68 e3 35 ce 4b 93 12 63 0a）。

图 6-15. 传输密钥

6.3. Zigbee 路由器
Zigbee 路由器可以组建分布式网络。如果它不组建分布式网络，则可以加入由 Zigbee 协调器组建的集中

式网络。

以下章节详细阐述了 Zigbee 路由器设备类型（与 Zigbee 协调器）的关联、调试、查找和绑定、属性报告

以及安全密钥交换过程。
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6.3.1. 调试

6.3.1.1. Zigbee 路由器/扩展灯具的网络引导

在下图中，数据包#6显示网络引导过程从路由器设备广播 Beacon Request开始。从协调器接收到信标

帧后，路由器设备通过 MAC 关联加入网络。

MAC 关联——设备尝试通过 MAC 关联加入网络（如同首次加入未知网络）。数据包#8至#12显示了

MAC 关联过程。有关 MAC 关联的详细信息，请参见 MAC 关联。

图 6-16. 网络引导——路由器

6.3.1.2. Zigbee 路由器/扩展灯具组建分布式网络

Zigbee 路由器可以组建分布式网络。成功组建分布式网络后，广播设备通告数据包和允许入网请求，以通

知其他正在搜索网络准备加入的路由器/终端设备。向终端设备/路由器发送信标请求后，父路由器以信标帧

进行响应，从而进行 MAC 关联。MAC 关联成功后，终端设备/路由器即加入网络。出于安全目的，通过传

输密钥在父路由器与终端设备/路由器之间传递链路密钥。有关详细信息，请参见网络安全模型。

6.3.2. 设备发现
设备通告——NWK 地址为 0x0401的 Zigbee 路由器设备广播了数据包#16和#17，其中显示 Device
Announcement。有关详细信息，请参见 Zigbee 设备配置文件（ZDP）。

图 6-17. 设备通告

图 6-18. 设备通告
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6.3.3. 服务发现
节点描述符——路由器/终端设备在查找和绑定前的初始化过程中请求节点描述符，以发现网络中协调器设

备的能力信息和其他信息。有关详细信息，请参见 Zigbee Specification Revision 22 1.0（05-3474-22）。

下图显示来自路由器和协调器节点的数据包#18和#20分别是 Node Descriptor Request和 Node
Descriptor Response。

图 6-19. 节点描述符

下图显示了来自协调器设备的 Node Descriptor Response。用户可在 ZigBee Device Profile
下看到以下内容：

• 协调器节点的 Capability Information
• Max Buffer Size
• Server Flags
• Descriptor Capability Field

图 6-20. 节点描述符响应

简单描述符——从协调器接收到 Identify Query Response后，路由器识别目标方端点并向目标方端

点（协调器）发送简单描述符请求。数据包#53和#55分别是来自路由器和协调器设备的 Simple
Descriptor Request和 Simple Descriptor Response。有关详细信息，请参见 Zigbee
Specification Revision 22 1.0（05-3474-22）。

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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图 6-21. 简单描述符——协调器和路由器

下图显示了来自协调器的 Simple Descriptor Response，其中列出了其支持的输入和输出簇。

图 6-22. 简单描述符响应

6.3.4. 查找和绑定
用户可对目标方端点/发起方端点进行如下配置：

• Zigbee 路由器/扩展灯具——作为发起方端点

• Zigbee 协调器/组合接口——作为目标方端点

下图显示数据包#47和#48分别是来自路由器和协调器设备的 Identify Query Request和

Identify Query Response。
路由器作为发起方，通过广播 Identify Query识别目标方端点。从目标方端点接收到 Identify
Query Response后，发起方向目标设备单播 Simple Descriptor Request。然后，发起方端点搜

索自身与目标方端点之间的任何匹配簇；对于找到的每个匹配项，在其绑定表中创建一个相应的条目。如

果存在组绑定请求，发起方端点将配置目标方端点的组成员关系。

在收到 Identify Query Response后，路由器识别目标方端点并请求 Simple Descriptor。数据

包#53和#55分别是来自路由器和协调器设备的 Simple Descriptor Request和 Simple
Descriptor Response。
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图 6-23. 查找和绑定——路由器

下图显示了 Simple Descriptor Response，其中详细列出了支持的输入和输出簇。

图 6-24. 简单描述符响应

6.3.5. 报告
下表提供了 Zigbee 协议栈中扩展彩色灯设备类型可用的客户端/服务器簇的详细信息。有关详细信息，请

参见 ZigBee Alliance Cluster Library Specification Revision 8（075123）。有关特定设备类型的强制或可选

簇的详细信息，请参见 Matter Device Library Specification（1.0）。

表 6-2. 支持的簇——扩展彩色灯

设备类型 簇 ID 服务器簇 客户端簇 属性标识符 属性名称

扩展彩色灯 0x0000 基本 基本 — —

0x0003 识别 识别 — —

0x0004 组 组 — —

0x0005 场景 — — —

0x0006 开/关(1) — 0x0000(1) 开/关(1)

0x0008 级别控制(1) — 0x0000(1) 当前级别(1)

0x0300 颜色控制 — — —

注：

1. 在此场景中，路由器/扩展灯具设备向协调器/组合接口报告开/关（0x0006）簇的 On/Off（0x0000）属性以及级别控制

（0x0008）簇的当前级别（0x0000）属性。

https://csa-iot.org/wp-content/uploads/2022/01/07-5123-08-Zigbee-Cluster-Library-1.pdf
https://csa-iot.org/wp-content/uploads/2022/11/22-27351-001_Matter-1.0-Device-Library-Specification.pdf
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扩展彩色灯是一种可以打开或关闭的照明设备。用户可调节光强度，绑定的控制器设备（颜色控制器）可

调整颜色。该设备支持通过色调/饱和度、增强色调、颜色循环、XY 坐标和色温来调整颜色。此外，用户

还可通过绑定的占用传感器进行开/关切换。

报告属性——设备使用 Report Attributes命令将其一个或多个属性的值报告给其他设备。各个簇定义

哪些属性需要报告以及报告间隔。

图 6-25. 报告属性——路由器

下图显示了 On/Off簇的 On/Off属性。

图 6-26. 开/关簇——开/关属性

下图显示了 Cluster: Level Control的 Current Level属性。
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图 6-27. 级别控制簇——当前级别属性

在此场景中，路由器设备和协调器设备配置如下：

• 路由器设备——报告开/关簇的开/关属性

• 协调器设备——级别控制簇的当前级别属性

6.3.6. 安全
有关集中式网络中信任中心与路由器之间的安全密钥交换，请参见安全。

6.4. Zigbee 终端设备
Zigbee 终端设备加入以下网络之一：

• 协调器——组建集中式网络

• 路由器——组建分布式网络

加入后，多传感器设备在连接到网络后开始报告传感器数据（如温度、占用状态、光照和湿度）的 ZCL 属

性。

以下章节详细阐述了 Zigbee 终端设备类型（与 Zigbee 协调器）的关联、调试、查找和绑定、属性报告以

及安全密钥交换过程。

6.4.1. 调试

6.4.1.1. Zigbee 终端设备/多传感器的网络引导
MAC 关联——终端设备尝试通过 MAC 关联过程加入网络（如同首次加入未知网络）。终端设备/路由器广

播 Beacon Request，网络中的协调器/路由器发送 Beacon Response。MAC 关联过程在终端设备/路
由器与协调器/路由器之间进行。有关详细信息，请参见 MAC 关联。
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图 6-28. 网络引导——终端设备

6.4.2. 设备发现
设备通告——数据包#20显示了 Zigbee 终端设备广播 NWK 地址为 0x017d的 Device
Announcement。有关详细信息，请参见 Zigbee 设备配置文件（ZDP）。

图 6-29. 设备通告——终端设备

图 6-30. 设备通告数据包

6.4.3. 终端设备超时
在加入或重新加入网络后，终端设备向其父节点发送一条含所需超时值的 End Device Timeout
Request命令。父节点在其邻近节点表中为相应的终端设备条目更新超时。父节点生成状态为 Success
且 Parent Information字段设置为 MAC Data Poll Keepalive方法的 End Device Timeout
Response命令。

终端设备通过发送 End Device Timeout Request命令将其超时要求告知给其父节点。这使得父节点

能够在子节点未在指定时间内与父节点通信时从邻近节点表中删除子节点条目。有关详细信息，请参见

Zigbee Specification Revision 22 1.0（05-3474-22）。

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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图 6-31. 终端设备超时序列

Child Parent Trust Center

APS Update Device

MAC Association or
NWK Rejoin Exchange

APS Transport Key
(NWK Key)

ZDO Device Announce

End Device Timeout Request Command
(Timeout is X)

End Device Timeout Response Command
(Success)

APS Tunnel Command

Setup Child Timeout
Receive Supported
Keepalive Method

Join Allowed

下图显示了 End Device Timeout设置的完整场景。数据包#24和#32分别显示了来自终端设备和协调

器设备的 End Device Timeout Request和 End Device Timeout Response。

图 6-32. 终端设备超时嗅探器日志

下图显示了 Parent Information字段设置为 MAC Data Poll Keepalive且 MAC Data Poll
Keepalive字段设置为 True的 End Device Timeout Response。
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图 6-33. 终端设备超时响应

6.4.4. 服务发现
路由器/终端设备在查找和绑定之前的初始化过程中请求 Node Descriptor，以发现网络中

Coordinator设备的 Capability Information和其他详细信息。有关详细信息，请参见 Zigbee 设

备配置文件（ZDP）。

数据包#28和#36分别显示了来自路由器和协调器设备的 Node Descriptor Request和 Node
Descriptor Response。数据包#40显示了终端设备对来自 Coordinator的 Node Descriptor
Response的 APS: ACK。

图 6-34. 节点描述符——终端设备

下图显示了来自 Coordinator设备的 Node Descriptor Response。在 ZigBee Device Profile
字段下，用户可看到以下内容：

• 协调器节点的 Capability Information
• Max Buffer Size
• Server Flags
• Descriptor Capability Field
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图 6-35. 节点描述符响应——终端设备

6.4.5. 查找和绑定
用户可对目标方端点/发起方端点进行如下配置：

• Zigbee 终端设备/多传感器——作为发起方端点

• Zigbee 协调器/组合接口——作为目标方端点

下图显示数据包#416和#419分别是来自终端设备和协调器设备的 Identify Query Request和

Identify Query Response。
终端设备作为发起方，通过广播 Identify Query识别目标方端点。从目标方端点接收到 Identify
Query Response后，发起方向目标设备单播 Simple Descriptor Request。然后，发起方端点搜

索自身与目标方端点之间的任何匹配簇；对于找到的每个匹配项，在其绑定表中创建一个相应的条目。如

果存在组绑定请求，发起方端点将配置目标方端点的组成员关系。

在收到 Identify Query Response（即，识别目标方端点）后，目标方端点请求 Simple
Descriptor。
数据包#425和#430分别是来自终端设备和协调器设备的 Simple Descriptor Request和 Simple
Descriptor Response。
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图 6-36. 查找和绑定——终端设备

6.4.6. 报告
下表提供了 Microchip Zigbee 协议栈中多传感器设备类型可用的客户端/服务器簇的详细信息。有关详细

信息，请参见 ZigBee Alliance Cluster Library Specification Revision 8（075123）。有关特定设备类型的强

制或可选簇的详细信息，请参见 Matter Device Library Specification（1.0）。

表 6-3. 支持的簇——多传感器/传感器设备类型

设备类型 簇 ID 服务器簇 客户端簇 属性标识符 属性名称

多传感器

0x0000 基本 基本 — —

0x0003 识别 识别 — —

0x0004 组 组 — —

0x0406 占用检测(1) — 0x0000(1) 占用(1)

0x0400 照度测量(1) — 0x0000(1) 测量值(1)

0x0402 温度测量 — — —

0x0405 含水量测量 — — —

0x0B05 诊断 — — —

注：

1. 在此场景中，终端设备/多传感器向路由器/扩展照明设备报告占用检测（0x0406）簇的占用（0x0000）属性和照度测量

（0x0400）簇的测量值（0x0000）属性。

• 配置报告——使用 Configure Reporting命令为簇的一个或多个属性配置报告机制。

下图显示了数据包#436，其中指示终端设备向协调器发出的 Configure Reporting Request。

图 6-37. 配置报告——终端设备

Direction字段指定是报告属性值还是接收属性报告。

https://csa-iot.org/wp-content/uploads/2022/01/07-5123-08-Zigbee-Cluster-Library-1.pdf
https://csa-iot.org/wp-content/uploads/2022/11/22-27351-001_Matter-1.0-Device-Library-Specification.pdf
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下图显示了 ZCL中 Reporting Configuration Record下的 Direction字段，该字段设置为

Received，表示协调器设备必须接收属性值。这也表明发送方（终端设备）可配置其报告机制，以向

接收方（协调器）发送/报告所需的属性。根据发送方当前的绑定状态，发送方会向接收方发送报告。

在上述场景（见图 6-37）中，用户必须使用 Configure Reporting命令配置终端设备，以向协调器

设备报告 Occupancy Sensing和 Illumination Measurement属性（光传感器的两个属性）。

占用传感器是一种测量和检测设备，可测量并报告某个区域内的占用状态。

光传感器是一种测量和检测设备，用于测量并报告光源发出的光强度。

图 6-37 显示了 Cluster: Illuminance Measurement的 Configure Reporting，其中终端设

备向协调器报告 Attribute: Measured Value。

图 6-38. 配置报告——照度测量

下图显示了 Cluster: Occupancy Sensing的 Configure Reporting，其中终端设备向协调器

报告 Attribute: Occupancy值。

图 6-39. 配置报告——占用检测

• 报告属性——设备使用 Report Attributes命令将其一个或多个属性的值报告给其他设备。各个簇

定义报告哪些属性以及报告间隔。
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图 6-40. 报告属性——终端设备

下图分别显示了终端设备向协调器报告 Illuminance Measurement簇的 Measured Value属性和

Occupancy Sensing簇的 Occupancy属性的详细信息。

图 6-41. 报告属性——照度测量

图 6-42. 报告属性——占用检测

6.4.7. 安全
有关集中式网络中信任中心与终端设备之间的安全密钥交换的详细信息，请参见安全。

6.5. Touchlink 调试
Zigbee 协议提供了一种称为 Touchlink的特殊调试方法，这是一种易于使用的接近度机制，用于将设备

调试入网。Touchlink调试簇提供了支持 Touchlink调试的命令。Touchlink调试命令集的命令标识

符范围为 0x00-0x3f，并使用跨 PAN（inter-PAN）传输服务进行传输。该过程的工作原理是：
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Touchlink发起方确定目标设备（待调试）的接近度并协商/传输网络参数。Touchlink调试过程可用于

组建新网络或将节点加入现有网络。Touchlink在称为发起方的节点上启动。ZCL 将 Touchlink作为簇

提供。发起方必须作为客户端支持 Touchlink簇，目标节点必须作为服务器支持该簇。如果节点上需要

Touchlink调试，可通过 Zigbee 基础设备属性 bdbCommissioningMode使能。有关 Touchlink调试

的详细信息，请参见 ZigBee Alliance Cluster Library Specification Revision 8（075123）。

例如，ColorSceneController（一种终端设备类型）请求灯具通过 Touchlink组建分布式网络，从

而将灯具引入网络。若要使能 Touchlink调试，可将颜色场景控制器靠近目标（灯具）设备，距离约为

20-30 厘米。

图 6-43. Touchlink 调试

Color Scene Controller - 
ZigBee End Device (Initiator)

Extended Lights-
ZigBee Router (Target)

https://csa-iot.org/wp-content/uploads/2022/01/07-5123-08-Zigbee-Cluster-Library-1.pdf
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7. 应用场景示例

7.1. 个人局域网（PAN）同信道共存
同一信道上可以存在多个 Zigbee 网络。下图说明了在已有 PAN 的情况下，可以启动第二个个人局域网

（PAN）。

下图显示了数据包#19和#20，其中提供了协调器 1（扩展 PAN ID 为 0xdeeb1）和协调器 2（EPID 为

0xdeeb7）为响应路由器在同一信道中发出的 Beacon Request（数据包#18）而发送的信标帧详细信

息。

图 7-1. PAN 信道共存

7.2. 端到端建立应用链路密钥
在安全网络中，当两个设备需要在安全链路上彼此通信时，必须从信任中心请求链路密钥。

下图显示了两个路由器之间的链路密钥建立过程。路由器 0x0b6f从信任中心请求链路密钥（见数据包

#24），以便与路由器 0x3779通信。

图 7-2. 两个路由器之间的链路密钥建立

信任中心使用 Transport Key命令将链路密钥发送到两个路由器。该链路密钥应用于路由器之间后续的

数据交换。数据包#47使用该链路密钥。下图显示了该链路密钥。
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图 7-3. 两个路由器之间的链路密钥建立
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8. Zigbee 绿色能量
以下是绿色能量（GP）基础设施设备类型：

• 绿色能量代理（GPP）设备或代理设备

• 绿色能量接收端（GPS）设备或接收设备

• 绿色能量组合（GPC）设备或组合设备

如果绿色能量设备（GPD）在附近，可以直接与接收设备进行调试。以下是两种调试方式：

• 单向调试

• 双向调试

8.1. 单向调试
• 对于单向调试，将接收设备置于调试模式，GPD 发送一条含 RxAfterTx-0的 Commissioning命令

（见数据包#74）以及所有设备详细信息，包括设备类型、安全级别、安全密钥类型和安全密钥等（见

下图）。

• 接收设备验证设备详细信息和安全密钥，并接受调试。接收设备在其接收表中为该设备创建新条目，广

播 GP 配对命令（见数据包#76和#78），并且设备以广播形式通告该新 GPD 的调试（见数据包#77和

#79）（见下图）。有关详细信息，请参见 Zigbee PRO Green Power feature specification Basic
functionality set（Version 1.1.1）。

图 8-1. 绿色能量调试——单向调试

8.2. 双向调试
• 对于双向调试，将接收设备置于 Commissioning模式，GPD 发送一条含 RxAfterTx-1的

Commissioning命令（见数据包#145）以及所有设备详细信息，包括设备类型、安全级别、安全密

钥类型和安全密钥等。

• 接收设备验证详细信息并以 Commissioning Reply进行响应（见数据包#146和#147）。如果在调

试数据包中请求了新的安全密钥和 PAN ID，Commissioning Reply可以包含这些内容。

• 当 GPD 接收并处理该 Commissioning Reply后，将发送含新密钥和 PAN ID 的 Success命令（见

数据包#150）。成功解密来自 GPD 的数据包#150（Success）后，接收设备在其接收表中添加新条

目，并为该设备广播 GP 配对和设备通告。有关详细信息，请参见 Zigbee PRO Green Power feature
specification Basic functionality set（Version 1.1.1）。

https://csa-iot.org/wp-content/uploads/2022/01/docs-14-0563-18-batt-Green-Power-Basic-specification-v1.1.1.pdf
https://csa-iot.org/wp-content/uploads/2022/01/docs-14-0563-18-batt-Green-Power-Basic-specification-v1.1.1.pdf
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图 8-2. 双向调试

8.3. 基本调试（信道配置）
• 如果设备不知道接收设备的工作信道，GPD 通过执行信道配置过程获取该信道。为获取工作信道，

GPD 向接收设备发送信道请求（见数据包#134和#137），接收设备通过信道配置命令以工作信道响

应 GPD。下图显示了数据包#134、#137和#138。
• 最初，GPD 并不知道工作信道，并在信道掩码中使能的多个信道中发送信道请求。

• GPD 在 Channel Request命令的帧控制字段（Frame Control Field，FCF）中指示其是否能够接

收。如果 FCF 字段的 Auto Commissioning设置为 0，则使能 RxAfterTx，反之则禁止。

• 从同一设备发送 Auto Commissioning = 0的信道请求后，GPD 接收信道配置。

• 由于发送数据包#134信道请求数据包中的 Auto Commissioning = 1且 RxAfterTx被禁止，因此

GPD 不接收信道配置。而对于信道请求数据包#137，Auto Commissioning = 0且 RxAfterTx被

使能，GPD 接收信道配置（见数据包#138）。

• GPD 在接收到该命令后将其工作信道更改为接收设备的工作信道。

• 当接收设备的工作信道与 GPD 的 RX 信道不同时，接收设备会短暂（5s）更改其信道，以便在 GPD 的

RX 信道中传送信道配置数据包。当工作信道与 RX 信道相同时，接收设备无需更改其信道。收到信道配

置后，GPD 无需再发送任何信道请求，可以继续进行调试。有关详细信息，请参见 Zigbee PRO Green
Power feature specification Basic functionality set（Version 1.1.1）。

图 8-3. 基本调试（信道配置）

8.4. 数据发送
如果网络中存在代理设备，GPD 通过代理将数据包发送到接收设备。在这种情况下，代理设备代表 GPD
设备发送 GP 通知。下图显示了 GPD 通过代理进行的数据发送。

https://csa-iot.org/wp-content/uploads/2022/01/docs-14-0563-18-batt-Green-Power-Basic-specification-v1.1.1.pdf


 AN4815
Zigbee 绿色能量

 应用笔记

© 2026 Microchip Technology Inc. 及其子公司

DS00004815A_CN - 63

图 8-4. GPD 通过代理进行数据发送

如果网络中不存在代理设备，GPD 将数据直接发送到接收设备。下图显示了 GPD 在没有代理情况下的数

据发送。

图 8-5. GPD 无代理数据发送
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9. 文档版本历史

表 9-1. 文档版本历史

版本 日期 章节 说明

A 2022 年 11 月 文档 初始版本
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